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What's New in fs.factory 2.11.01 (23/12/2023)
Provided a workaround for the OSX Java file selector bug that reports a non existent directory when
you have double clicked a directory to select it.

• 

Improved registration process. You now no longer have to quit the program to activate the disabled
features once registered and activated.

• 

Application rebuild to stay current with latest version of Java 17, required libraries and build tools.• 

Previous Versions
V2.11.00 (10/09/2023)

Added the ability to do a manual import of data from the FS1r, which is about 12 times faster than the
commanded import.

• 

Fixed a bug in the database view that was preventing selection of different database views.• 
Fixed a bug in the open/save workspace function that was preventing Librarian Windows being
saved/restored by the workspace file.

• 

V2.10.01 (20/12/2022)

Fixed a bug in drag and drop (most noticeable in kronos.factory and montage.factory due to file sizes)
where drag and drop operations were occasionally failing and providing an error message about copy
and paste not being possible.

• 

Fixed a bug where using the View/Refresh menu option killed drag and drop.• 
Updated the status bar's file name display to show a truncated path (with the filename fully visible) if
the the full path will not fit in the available space.

• 

V2.10.00 (08/05/2022)

Updated how the applications are built. The Java Runtime is now embedded and updated to Java 17
as the minimum version. There is no longer a need for a standalone version of Java to be installed

• 

New installers for OS X (DMG), PC (MSI) and Linux (DEB) and basic ZIP and TAR packages.• 
The OS X DMG package is notarized for compatibility with the OS X security model.• 

V2.9.02 (05/07/2020)

Fixed problem on OS X Mojave and Catalina which was preventing access to protected folders.• 

V2.9.01 (28/04/2020)

Fixed a bug with the default library path that was creating a new library under the main library.• 
Introduced the Preferences option to allow the library path to be set.• 

V2.9.00 (18/04/2020)

If you double click on a voice or performance, it will be sent to the synth's edit buffer. If you use a
triple click action instead on a performance, the MIDI router is automatically opened after the
performance is exported (note this triple click does not work on voices as you need to first confirm the
voice edit buffer which stops a triple click from being detected).

• 

The application now supports MIDI data logging to the application log, which can be enabled in the
Preferences/Misc Tab. It is recommended that this is not normally turned on, and it is only needed
when required to help me diagnose any MIDI issues that are reported if you are experiencing any
such issues.

• 

The Minimum Java Version is now Java 11, and I have rebuilt the applications with the latest support
libraries. The migration to Java 11 is a significant step, as I have been help back from migrating to
Java 9 and above due to Java PC MIDI issues that were causing garbled MIDI port names, which
made it impossible to select MIDI ports. These issues are now resolved in the recommended JREs.
Please see the Java Support page on the website for more details.

• 

The applications support iMac Retina displays.• 

fs.factory V2.8.05 (22/12/2018)

No functional changes. The Application is now built using new build tools and libraries, as some of the
ones I was using were obsolete and no longer supported. I am changing these as part of longer time
migration plans to Java 9 and above.

• 

The Minimum Java Version is now Java 8, as Java 7 as Oracle no longer provide public updates to
Java 7.

• 

V2.8.04 (22/10/2017)

OSX Users - Updates to how devices are named in CoreMIDI4J to provide better device identification,
which means that you may need to reselect your devices in MIDI Preferences as they may now be

• 
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named differently.
OSX Users - I've finally figured out how to get rid of the confusing default drag image that OS X adds
on top of the drag images that I am generating.

• 

Small GUI update to change background colour of object selections (the default colours since Java 7
are not good).

• 

V2.8.03 (13/08/2017)

Further improvements to error logging.• 

What's New in fs.factory V2.8.02 (08/07/2017)

General improvements in MIDI report handling to report identified port issues to the user.• 
When importing many items and MIDI timeouts are being experienced, then you now have the option
to abort or continue the transfer

• 

Fixed bug in the database that prevented the author being correctly displayed when it was being
edited, and added context menu options to allow multiple objects to have the Author value edited at
the same time.

• 

Added application error logging to make debugging easier.• 

V2.8.01 (24/12/2016)

Improved database access performance when editing information.• 

V2.8.00 (25/07/2016)

CoreMidi4J is now embedded in the application for OS X Users. So there is no longer a need to
download and install a MIDI Service Provider extension for OS X.

• 

V2.7.00 (28/03/2016)

Updated all x.factory Librarians to use CoreMID4J on Mac OSX.• 
Updated all x.factory Librarians to use Launch4J application launcher on PC.• 
The minimum JRE version is now Java 7.• 

V2.6.00 (28/06/2014)

Updated all x.factory Librarians to use a new automated licensing system.• 

V2.5.00 (27/08/2012)

Updated MIDI Router to allow the MIDI Channel to be either the channel sent by the source device, or
to be the channel specified in the MIDI Options Dialog.

• 

V2.4.00 (23/08/2012)

Updated application to work with MMJ on OS X to provide access to external MIDI devices. The move
to MMJ is required because the Mandolane MIDI SPI is no longer supported and doesn't work on OS
X Lion and above.

• 

The MIDI Router is now available on the MIDI Menu.• 

V2.3.00 (19/01/2012)

Updated Java Launcher to work on OSX Snow Leopard and OSX Lion.• 

V2.2.02 (07/11/2011)

Updated Windows Installer to detect 32 or 64 Java Runtime Environments (JREs) and to configure
the application launcher to make use of a 64 bit JRE if available.

• 

Fixed bug that was preventing the selection of Table Views if the application was not registered• 

V2.2.01 (29/10/2011)

Fixed a bug that was not allowing Files in the Library to have the Author parameter set.• 

V2.2 (11/08/2011)

Batch importer for importing FS1R SYSEX and MIDI bulk dump files into the Library• 
MIDI Bulk Dump files (embedded SYSEX) are now preserved, not converted to SYX• 
You can now create SYSEX or MIDI file types• 
"Save As" allows you to change the file type• 
The default view in a Table is now Performances, as I felt that this is more logical given that this is the
main FS1R operating mode.

• 
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There is now a preference settings to indicate if files should be created with a System node• 

V2.1.00 (02/07/10)

Added the DX7 batch file import wizard.• 
Fixed problem with DX7 Import that rejected a lot of files due to checksum errors.• 

V2.0.02 (22/12/09)

Added "User Formant Sequences" check box to the "Misc Options" Preferences Tab. When this is
checked, fs.factory will only send and receive the first 64 user voices.

• 

Increased MIDI buffer size maximum limit to 8,192 bytes.• 

V2.0.01 (16/12/2009)

Corrected problem where file data paths on non-English locales were not being found.• 
Updated license code to allow fs.factory to unpack a license.zip if it is found in the license folder,
which simplifies installation particularly for Mac OSX users, where the standard zip extractors were
causing problems with the license file. fs.factory can also now detect a license.lic file if this has been
inadvertantly extracted.

• 

V2.0.00 (23/11/2009)

Library support has been added, which allows you to keep all of your favourite items (Voices and
Performances) in one Library database, and then sort and filter them to find the patch that you want.
This feature is only available for registered users.

• 

fs.factory can now read MIDI (.MID) files with embedded FS1R SYSEX data and create a SYSEX
data file from the MID file.

• 

You can create a performance bank to match a voice bank in a file.• 
Improved DX7 import to correct bug with the creation of performances from DX7II performances, and
performances are now automatically created if the file being imported (DX7 or DX7II) doesn't have
any defined.

• 

V1.1.00 (20/08/2007)

fs.factory can now bulk convert DX7 and DX7II SYSEX files. The FS1R itself can only convert voice
edit buffer SYSEX data.

• 

V1.0.00 (26/06/2006)

First release.• 
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Installation and Configuration of fs.factory
fs.factory is downloaded as a self installing file, so installation is automatic, and for most users little else, if
anything, needs to be done to get up and running.

A native installer for Windows is also available.

This section is only relevant to installing additional items not included as part of the fs.factory installer.

Installing MIDI Extensions for MacOS X
If you wish to use the MIDI support provided on Mac OSX, then a Java MIDI Service Provider extension is
required.

The extensions provide MacOS X Java programs access to all CoreMIDI devices

An extension is required because, historically, the Java implementation on OS X is not able to access external
MIDI devices. Apple/Oracle claim to have fixed the external MIDI device access problem in its Java
implementation. However, it appears that only "simple" MIDI messages are now supported. SYSEX data
transfer (essential for transferring synth data) is not supported.

fs.factory now embeds CoreMIDI4J in the application package, so you no longer need to download and install
it separately. However, if you still require an SPI for other Java MIDI software then you will need to ensure
that you have the latest compatible version of CoreMIDI4J, as if an SPI is installed in the
/Library/Java/Extensions folder then this will override the version of CoreMIDI4J embedded in fs.factory.

If you are not using any other Java software that requires MIDI access, it is best to remove any existing
version of CoreMIDI4J from the /Library/Java/Extensions folder so that fs.factory can access the CoreMIDI4J
version embedded in the package. That way you can ensure that fs.factory is always using the latest
compatible version of CoreMIDI4J.

fs.factory will warn you if it detects an earlier version of CoreMIDI4J. It will still function, but will not benefit
from recent CoreMIDI4J bug fixes or enhancements.

If you need to retain a version of CoreMIDI4J in the /Library/Java/Extensions folder then you can always
download the latest version of CoreMIDI4J.jar from  CoreMIDI4J Releases

Once you have downloaded CoreMIDI4J.jar it needs to be copied to the /Library/Java/Extensions folder. You
will need to provide administrator permissions to copy the files.

Once installed, when running the librarians and selecting the MIDI ports to use, select the ports prefixed with
CoreMIDI4J -. For example my Edirol UA-25 interface that I use for testing on OS X is listed as CoreMIDI4J -
UA-25. The latest version of fs.factory will only list CoreMIDI4J devices.
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Registering fs.factory
You need to register fs.factory to allow MIDI data to be exported to the FS1R, for data to be saved to your
computer and for Library Support to be enabled.

Please refer to the x.factory Librarian Registration Page for details on how to register fs.factory.
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Running fs.factory
Starting up fs.factory is as simple as starting any application, simple double click on the icon and you're away.

If you have registered fs.factory, then the Library will be created (if it doesn't already exist) and opened.

During start-up, a "Splash Screen" is shown. This stays visible until a few seconds after the program has
loaded and is ready for use, but can be dismissed at any time by clicking on the Splash Screen.

fs.factory remembers the size and position of the main window between sessions, so the main window will be
sized and positioned as you left it the last time.

PC
Simply double click on the program icon for the program either in an Explorer shell, or from the desktop if you
let the installer placed a shortcut there.

You can also select the program from the Start Menu. By default, fs.factory can be found under the x.factory
Librarians Program Group.

IMPORTANT NOTE: If the application is failing to launch on a PC with a 32 bit version of Windows, then
please read the Section on adjusting the JRE Memory Configuration, as the failure is more than likely to be
due to an out of memory condition.

MAC OS X
Navigate to the Applications folder in Finder and double click the fs.factory application.

You can also create "Aliases" of the application and place them anywhere you wish, such as on the desktop

To make an alias you can choose any one of the following methods:

Click the fs.factory item you have just identified and hold down the mouse button. Then, while holding
down the Command and Option keys simultaneously, drag the item to where you want the alias to
appear then let go of the mouse button and finally release the two keys. This will create an alias at
your desired location. While dragging, the ‘ghosted’ item will display a shortcut arrow which will remain
on the aliased icon when it has been created.

• 

Hold down the Ctrl key, and then click the fs.factory item as identified previously. The context menu
will be displayed, and one of the choices will be Make Alias. Click that option, and then release the
key. The fs.factory alias will appear next to the original item and can be dragged to your location of
choice.

• 

Select the fs.factory item you identified previously by clicking it once then press Command-l
(lowercase L). The fs.factory alias will appear next to the original item and can be dragged to your
location of choice.

• 

Click the fs.factory item once to select it, and then from the File menu, select Make Alias. The
fs.factory alias will appear next to the original item and can be dragged to your location of choice.

• 

Note that if your alias does not have a small arrow in the lower left corner then you have not correctly created
an alias and have probably just dragged the application launcher to a new location. If so, drag it back to the
Application folder and start again.

Command Line
You can also startup fs.factory from a command shell (e.g. MsDOS). Simply change directory to where
fs.factory is located and type the following:

java -jar fsfactory.jar
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The fs.factory Window
The main fs.factory window looks like this

The fs.factory user interface is a Multiple Document Interface (MDI), which allows you to have more than one
file open at a time.

The interface is divided into the now familiar layout of (from top to bottom):

The Title Bar• 
The Menu Bar• 
The Tool Bar• 
The Desktop• 
The Status Bar• 
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Menu Bar
The fs.factory menu bar provides a means of selecting common operations; typically those that affect a
complete file, or those that don't fit naturally upon a context sensitive popup menu.

Keyboard Shortcuts are provided for common operations.

fs.factory also provides context sensitive popup menus, which are accessible by right clicking over data
shown in a Child Window. Naturally the contents of the popup menus varies according to the type of data over
which the menu was popped up.

Main Menu Headings

The following menu headings are available.

File Menu• 
Edit Menu• 
View Menu• 
MIDI Menu• 
Tools Menu• 
Window Menu• 
Help Menu• 
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The File Menu

The File menu provides the following options:

New ...

Shows the New File Dialog, which allows you to create a new file.

Open ...

Shows the Open File Dialog, which allows you to open a specified file.

Save

Saves a file using its current name.

If the file in question is a newly created file, then the Save File Dialog is brought up to allow a name to be
entered.

This option is only enabled if your copy of fs.factory is registered.

Save As ...

Saves the selected file after a name has been entered in the Save File Dialog.

This option is only enabled if your copy of fs.factory is registered.

Save All

Saves all open files that have been modified using their current names.

This option is only enabled if your copy of fs.factory is registered.

Open Workspace ...

This option allows you to select a previously saved Workspace, which is a Collection of open windows, and
the size and positions within the main fs.factory window.

When you select this option, a dialog opens which allows you to select an fs.factory workspace file (EXW).

Save Workspace ...

This option allows you to save the current size and position of the main fs.factory window, and the
arrangement of the open windows within fs.factory to a Workspace file.

This option is only enabled if your copy of fs.factory is registered.

Export to

This option brings up the following sub menu:
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These options allow you to Export the data in the currently selected file to a variety of different formats.

This option is only enabled if your copy of fs.factory is registered.

Exit

Exits the fs.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.
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The Edit Menu

The Edit menu provides the following options:

Undo

Undos the previous edit stored in the Undo Buffer.

Redo

Redos the next edit stored in the Undo Buffer.

Clear Undo Buffer

Clears the Undo Buffer.

Cut

Places a copy of the selected Object(s) onto the Clipboard and deletes the selected Object(s) from the file.

Copy

Places a copy of the selected Object(s) onto the Clipboard.

Paste

Copies the Object(s) on the Clipboard into the highlighted location within the current file.

Find ...

fs.factory supports the ability to find Objects either by name or by category.

Searches start from the currently selected Object.

Selecting the Find ... option brings up the Find dialog, that allows you to specify the string to search for, along
with options that can be used to refine the search.

Find Next

If you have defined the Find criteria within the Find dialog, then this option will repeat the search using the
same criteria.

Find Category ...

You can also search by category be selecting Find Category ... option, which brings up the Find Category
Dialog.

Find Next Category

If you have defined the Find Category criteria within the Find Category dialog, then this option will repeat the
search using the same criteria.;

Goto ...

Selecting this option brings up the Goto Dialog, which allows you to quickly navigate to a numbered Object.
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The View Menu

The View menu provides the following options:

Note how some of the options change depending on whether or not the Child Window is split.

When the Child Window is split the Left/Top Pane and Right/Bottom Pane menu options have the following
sub menu.

Tool Bar

When checked the fs.factory Tool Bar is visible.

Status Bar

When checked the fs.factory Status Bar is visible.

No Split

When checked the current Child Window is not split.

Horizontal Split

When checked the current Child Window is split horizontally.

Vertical Split

When checked the current Child Window is split vertically.

Tree

When checked the main/left/top pane in a Child Window displays data in a Tree View.

Table

When checked the main/right/bottom pane in a Child Window displays data in a Table View.

Refresh

Refreshes all open Child Windows.

This command is provided in case the screen is not properly updated following an edit operation. There are a
couple of odd bugs I cannot track down on screen updates. So if you come across them as well, then this
command will force a redraw of the windows.

Preferences ...

Opens the fs.factory Preferences Dialog.
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The MIDI Menu

The MIDI menu provides the following options:

Import From MIDI

Imports Voices and Performances from the FS1R via MIDI to the currently selected Window.

Export to MIDI

Exports Voices and Performances to the FS1R via MIDI from the currently selected Window.

Note: The Export To MIDI option is only enabled if you have registered fs.factory.

MIDI Router ...

Opens the MIDI Router Dialog which allows you to use another keyboard to audition FS1r Data.

MIDI Preferences ...

Opens the Preferences Dialog with the MIDI Preferences Tab active.
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The Tools Menu

The Tools menu provides the following options:

Master Patch List ...

Opens the Master Patch List dialog.

This option is only enabled if your copy of fs.factory is registered.

Library Information ...

Opens the Library Statistics dialog.

This option is only enabled if your copy of fs.factory is registered.

Batch Import to Library ...

Opens the Batch Import To Library dialog.

This option is only enabled if your copy of fs.factory is registered.

Batch Import DX7 Patches ...

Opens the Batch Import DX7 Patches Wizard.

This option is only enabled if your copy of fs.factory is registered.
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The Window Menu

The Window menu provides the following options:

In the example given above, you'll see that after the predefined menu options there are menu options that
allow you to select the windows currently open within fs.factory (FSWorldColl.SYX and CYBER.SYX in our
example menu).

Tile Horizontal

Arranges all non-minimised Child Windows along the horizontal axis.

Tile Vertical

Arranges all non-minimised Child Windows along the vertical axis.

Maximise Windows

Maximises all Child Windows so they all occupy the size defined by the desktop.

Restore Windows

Restores all maximised/minimised Child Windows to their normal state.

Minimise Windows

Reduces all Child Windows to their iconised state.

View FS1R Synthesizer Data

Opens or closes the FS1R Synthesizer Window which provides a view on preset and user FS1R synth data.

View FS1R Library

Note: This menu option is only visible if you have registered fs.factory.

Opens or closes the FS1R Library Window which provides a view on the FS1R Library.
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The Help Menu

The Help menu provides the following options (OS X and Windows versions are shown):

Search

OS X only. This is a standard OS X Menu function currently not working with fs.factory. One day....

Get Help on fs.factory ...

Displays the fs.factory Online Help system.

View Tips and Tricks for fs.factory ...

Displays the fs.factory Tips and Tricks Dialog.

View PDF Documentation for fs.factory ...

Displays the PDF documentation for fs.factory. Note that there needs to be a registered viewer for PDF files
on your system for this command to work

View License Agreement for fs.factory ...

Displays the fs.factory License Agreement in a dialog box.

View License Agreement for fs.factory ...

Provides a link to the x.Librarian's Support Page.

About fs.factory ...

This menu option is not available if the host operating system is OS X. On OSX there is an About fs.factory
menu option in the  fs.factory Application Menu.

Displays the fs.factory About Dialog, which provides some basic information about the program, such as the
version number.

Register and Activate fs.factory ...

Displays the fs.factory registration and activation Dialog.

See the Registration Section for details of how to register fs.factory.
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Tool Bar
The Tool Bar contains buttons for common operations, such as opening and saving files.

   Creates a new file
   Displays the Open File Dialog to allow you to select a file to open
Saves the currently selected file

   Displays the Save As Dialog to allow you to select a different name for the currently selected file
Saves all the open files to disk

   Cuts the selected Objects and places them on the Clipboard
   Copies the selected Objects and places them on the Clipboard
   Pastes the contents of the Clipboard to the current selection
Undos the previous edit
Redos the previous edit

   Displays the Find Dialog to allow you to define the search criteria and then search for the first occurrence
   Searches for the next occurrence of the search criteria defined in the Find Dialog
   Imports Voices/Performances from the FS1R via the MIDI interface
   Exports Voices/Performances to the FS1R via the MIDI interface
   Displays the Preferences dialog where you can configure fs.factory
   Displays the fs.factory Online Help index page
   Enables Context Sensitive Help
   Displays the Tips and Tricks Dialog
   Displays the About Dialog

The Save and MIDI export buttons are only enabled if fs.factory is Registered.

The Tool Bar can be dragged and made a floating toolbar by clicking and dragging the handle to the left of the
Tool Bar.

The Tool Bar can also be dragged to a different window border other than the top border.

The Tool Bar can be hidden/unhidden by the Tool Bar menu option on the View menu.

The Tool Bar whilst floating can be docked once more by closing it.
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Desktop
The Desktop portion of the window is where the FS1R data is portrayed. Several files may be opened and
shown within Child Windows upon the Desktop portion of the window. The following example shows
three Child Windows open on the Desktop.

The Window Menu provides menu options to:

Tile (either vertically or horizontally) all Child Windows that are not iconised• 
Minimise all Child Windows• 
Maximise all Child Windows• 
Restore all Child Windows• 
Select a specific Child Window• 
Open the FS1R Synthesizer Window• 
Open the FS1R Library Window• 

When a file is opened, a Child Window is added to the Desktop Area.
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Child Window
The Child Window provides the View upon the data within the file it is associated with.

The Child Window is maximised by default when it is opened, and can be minimised, restored or closed by the
buttons to the right of the Child Window's title bar.

The menu options on the View menu can be used to change the View to a Table view, which can show either
a Voice Table or a Performance table.

It's also possible to have either a horizontally or a vertically split View which can show any of the following
combinations:

A Tree and a Table• 
A Table and a Tree• 
Two Trees• 
Two Tables• 

The default Child Window View applied when a file is opened is set in the Default View Tab of the Preferences
Dialog.

The following example shows a Child Window that is split and showing both a Tree View and a Table View on
the same data.

The Tree and Table views support drag move and drag copy operations, and the views will automatically
scroll whilst drag operations are in progress.

fs.factory also provides two special Child Windows:

The FS1R Synthesizer Window.• 
The FS1R Library Window (This Window is only available if you have registered fs.factory).• 
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Tree View

The Tree View shows the FS1R data as a hierarchical tree, and can show more information than the Table
View. The following example shows a split Child Window with two Tree Views.

Basically, information is shown as a set of hierarchical Objects. Objects may have children attached to them,
and they themselves may have further child Objects (e.g. a Voice Object, has a child Object for its Voiced
Operators, and this Object groups all the Voiced Operators of the Voice).

The basic tree structure is a Root Object at the top of the tree under which are various Object Collections
which themselves contain further data.

You can double click on an item, and if the item is a voice or performance, it will be exported to the synth's
Edit buffer

You can also triple click on an item, and if the item is a performance, it will be exported to the synth's Edit
buffer and the MIDI Router will also be opened

Objects are displayed in one of two colours:

Black if the Object is not referenced by another Object• 
Blue if an Object is referenced by another Object (e.g. a Voice being used within a Performance)• 

The Tree View allows multiple Objects to be selected, which is useful for performing operations only upon
certain Objects. You can only perform operations upon Objects of the same type.

If you wish to perform an operation upon all Objects in a Collection, simply select the Collection containing the
Objects.
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Table View

The Table View provides a more high level overview of the data than the Tree View, and the representation of
the data is more compact. The following example shows a Child Window with a single Table View providing
information on a file's Voices.

The Table View can only show one Collection of Objects at a time.

Currently the Table View can show Voices in SYSEX files or Performances in SYSEX files.

You can select whether a Table View shows Voices or Performances by right clicking within the table to
access the context sensitive menu, upon which can be found menu options to select either a Voice Table or a
Performance Table.

Each row within the table shows one Object.

You can double click on a row, and if the item is a voice or performance, it will be exported to the synth's Edit
buffer

You can also triple click on an row, and if the item is a performance, it will be exported to the synth's Edit
buffer and the MIDI Router will also be opened

The Table View's context sensitive popup menus support editing operations. The cells in a Row that contain
the Object's Category and Name can be directly edited by clicking in them.
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FS1R Synthesizer Window

The FS1R Synthesizer Data Window is made visible by ensuring the View FS1R Synthesizer Data option in
the Window Menu is checked.

This Child Window is a special View that shows the following FS1R Preset and User Data Collections:

Preset Voices• 
Preset Formant Sequences• 
User Voices• 
User Performances• 

The purpose of showing these User Data Collections is to allow drag and drop transfers of User Voices and
User Performances between fs.factory and the FS1R via the MIDI Interface.

The Preset Voice and Formant Sequence data can be drag copied onto performance parts and performance
formants to reference preset data.
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FS1R Library Window

Note: This Window can only be opened if you have registered fs.factory.

The FS1R Library Data Window is made visible by ensuring that the View FS1R Library option in the Window
Menu is checked.

This Child Window is a special View that shows the contents of the FS1R Library.

Like the standard Table View, you can select the view of type of objects that you wish to view (e.g. Voices,
Performances, etc.), which includes Files and Authors that are stored in the Database.

The window can be configured to be either a Tree or a Table view. The Table view is recommended because
filtering capabilities are available, which are described below.

FS1R Library Table View Columns

The following columns can be found in the Library table.

Category The Category of an Object. Not all Objects have a defined Category
Name The Name of an Object. Note that this name can be up to 50 characters long, so you can provide

a more meaningful name for an object within the Library (the original name is preserved for when
the object is copied from the Library).

Rating Each Object object can be assigned a rating, from unrated to five stars. Filtering on this column
will allow you to quickly find you favourite items.

Comment Each object can have a comment associated with it of up to 100 characters. For example, you
could use this field to contain keywords that you use to describe a sound's character in more
detail. This could help you to define a filter to search for a sound.

Author You can define the Author for each Object. This field defaults to "Unknown" when objects are
added to the Library. You can setup fs.factory to prompt you for an Author name when a new file
is being added to the database.

Source The name of the source file that an Object was copied from when it was added to the Library.
Table Sorting

You can sort a table by a column by clicking on a column heading in the table header. for example to sort
voices by name, then click on the Name column heading. The sorting will cycle through the following states
each time you click a column header:

Unsorted• 
Sort Ascending• 
Sort Descending• 

Data Export

If you check the Automatically Export Selected Item option, then when you select a Voice it is automatically
exported to the Voice Edit Buffer.
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This, for example, allows you use the cursor keys to move though the library Voices and have them
automatically exported to the Edit Buffer without having to do anything else. Please note however, that with
this option enabled, then the scrolling is slowed down. Don't forget that you can double click on a Voice to
export it.

Table Filtering

The database table provides a very comprehensive filtering capability, which allows you to filter on any
column or combination of columns. For example, you can filter on voices with a name that contains the phrase
"Fred", combined with a category filter for "pads", combined with a type filter for AWM voices, and finally filter
for those which have a three star rating.

You can enter a filter for each column using the filter header that is above the table column names.

Table filtering works in conjunction with table sorting

A filter with a grey background is restricted to filtering by items that you can select from the drop down list. For
example, a rating value can only be unrated or rated between 1 and 5 stars

A filter with a yellow background allows you to enter a PERL Regular Expression string that acts as a filter.
Consider the following PERL examples for filtering by name:

drum will match all names containing the phrase drum (anywhere in the name);• 
^t will match all names beginning with the letter T ('^' anchors the search to the start of the name);• 
[0-9]$ will match all names ending with a number character between 0 and 9. ('$' anchors the search
to the end of the name);

• 

^M[0-9] will match all names starting with letter M followed by a numeric character.• 

That is just an overview of how you can use regular expressions for filtering. More details for how you can
form regular expression pattons can be found on the PERL Regular Expression Page

The drop down list for a Perl Regular Expression filter provides a history of the search terms entered during
the session.

Table Filter Controls

At the bottom of the table is a toolbar with the following controls:

Enable Filter Turns the filter on or off.
Configure Filter Brings up the Configure Filter dialog box allowing you to control the default behaviour of

how the Rating, Comment, Author and Source File columns are filtered.
Reset Filter Resets the filter.
Table Filter Configuration

When the Configure Filter Dialog button is selected, the following dialog appears that allows you to control
the behaviour of the filter for specific columns.

Rating - allows you to select whether or not an exact match is required, or if the filter is to allow
ratings greater than or equal to the one shown.

• 

Comment - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 

Author - allows you to select if a PERL Regular Expression can be entered, or if choices are restricted
to the choices provided in the drop down dialog.

• 

Source File - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 
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Status Bar

The Status Bar provides the following pieces of information (from left to right) for the Child Window which is
currently selected:

The name of the file currently open, if any. If no file has been selected then this field is blank• 
The type of the file• 
Whether or not the file has been modified• 
If the left/top split pane is a table this indicator identifies what the table is showing (Voices or
Performances)

• 

If the right/bottom split pane is a table this indicator identifies what the table is showing (Voices or
Performances)

• 

The Status Bar can be hidden/unhidden by the Status Bar menu option on the View menu
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Program Features
fs.factory provides the following features:

File Operations• 
Undo/Redo Support• 
Clipboard Support• 
MIDI Support• 
Library Support• 
Find and Goto Support• 
Editing Features• 
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File Operations
fs.factory supports the following file operations:

Create New Files• 
Open Existing Files• 
Save Files• 
Open and Save Workspaces• 
Export Data• 
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Create New File

When the New File ... option from the File Menu or the  button on the Toolbar is selected, the following
dialog appears to allow you to select the type of file to create:

The new data file is given a name in the form of "fsfactory_n", where n is a number that increments every time
a file is created.

Note, this is different from initialising data in a file, as a totally new file is created.
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Open Existing File

When the Open ... option from the File menu or the  button on the Toolbar is selected the following dialog
will appear, allowing a file to be selected.

fs.factory checks to ensure that the selected file is a valid Yamaha format file, and an error dialog will appear if
the file is not valid.

You can open FS1R SYSEX files or DX7/DX7II SYSEX files (if fs.factory is registered).

If a file selected for opening is already open, fs.factory will ask if you want to replace the file that is in memory.

 Program Features 29



Save Open Files

When you save a file to disk using: the Save As ... command from the File Menu, or when a file created using
the New ... command from the File Menu is saved for the first time, the following dialog appears to allow you
to select a name for the file

You can save a file to a different type by selecting Files of Type to be the new file type.
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Workspaces

fs.factory allows you to save the current size and position of the main fs.factory window, and the arrangement
of the open Child Windows within fs.factory to a file known as a Workspace.

This allows you to save a Workspace you are using for future recall at a later date.

The following for each Child Window remembered:

Window size, position and status (normal, maximised or minimised)• 
Horizontal/Vertical Splits, including split position• 
Pane type(s) (e.g. Tree, Voice Table or Performance Table)• 
Tree node expansion status• 
Table column widths• 
Scroll position of the pane(s)• 
Selection state of the tree nodes, or table rows• 
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Export Data

fs.factory allows you to export the data in the currently selected file to a variety of different formats.

HTML• 
XML• 
Cubase VST Patch List• 
ProTools Patch List• 
Sonar Patch List• 
SpreadSheetML• 

HTML ...

This option allows you to export a listing of the data in HTML format.

The following dialog will appear, allowing you to select the features to be exported:

XML ...

This option allows you to export a listing of the data in XML format.

The following dialog will appear, allowing you to select the features to be exported.

This export option is intended to provide a means of importing FS1R data into other programmes, e.g. a
database

Cubase VST Patch Script ...

This option allows you to export a listing of the Voice/Performance data in Cubase VST patch script format.

This allows you to create patch scripts for use within Cubase to ease the selection of patches within the
Cubase environment.

Consult your sequencer documentation for details on how to install the patch scripts within your sequencer.

Protools Patch Script ...

This option allows you to export a listing of the Voice/Performance data in Protools patch script format
(MIDMAN files).

This allows you to create patch scripts for use within Protools to ease the selection of patches within the
Protools environment.

Consult your sequencer documentation for details on how to install the patch scripts within your sequencer.

Sonar Patch Script ...

This option allows you to export a listing of the Voice/Performance data in Sonar patch script format.

This allows you to create patch scripts for use within Sonar to ease the selection of patches within the Sonar
environment.

Consult your sequencer documentation for details on how to install the patch scripts within your sequencer.

 SpreadSheetML ...

This option allows you to export a listing of the data in Microsoft SpreadSheetML format.
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The following dialog will appear, allowing you to select the features to be exported.

This export option is intended to provide a means of importing FS1R data into either Microsoft Word or Excel,
which is a great way to start documenting your patch collections
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Undo Buffer
fs.factory supports a multi-level Undo/Redo Buffer facility on all edits.

The number of edits which are stored is 100.

The Undo/Redo commands can be found both within the Edit Menu, and on the Toolbar.

Please note that the undo buffer is global across all open files, and is cleared when any file is closed. This
may be improved in later releases.

The undo buffer can be cleared by the selecting the Clear Undo Buffer option on the Edit Menu. The
intention of this feature is to help cope with low memory situations, as it will free up the memory used by
stored edits.
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Clipboard Support
The fs.factory clipboard works just like the clipboard in other applications. It allows you to place an Object or a
copy of an Object upon the clipboard and then paste that Object elsewhere within a file or another file.

You can Cut/Copy either a single Object or a Collection of Objects onto the clipboard.

You can only paste from the clipboard to the current location in a file if it makes sense to do so. For example:

You cannot paste a Voice onto a Performance• 
You cannot paste ten Voices at the end of a Voice Collection if the selection is at Voice 120 or higher• 

The fs.factory clipboard is "local" to the application, and only fs.factory Objects can be placed upon it.

fs.factory does not support the system clipboard so it is not possible to cut and paste between fs.factory and
other applications. I don't think this is a major drawback because I cannot think of any circumstances where
you would wish to do this!
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MIDI Support
To use fs.factory MIDI Export support, your copy of fs.factory needs to be registered.

Configuring MIDI Support

To configure MIDI support, go to the MIDI Preferences tab in the Preferences Dialog, and set up the following:

Input MIDI Port and Output MIDI Port should be set to the MIDI port(s) to which the FS1R is
connected

• 

SYSEX Device Number should match the FS1R Device Number setting • 

If the Device Number on the FS1R is set to  ALL then it will accept data for any SYSEX Device.

You can check that these settings work by pressing the Test FS1R MIDI Settings button. When you press
this button a test message is sent to the FS1R and the subsequent Dialog will tell you if communication was
successful or if there was a problem.

The above steps set up the basic communication mechanism for MIDI support, and you then can set up the
remaining options according to your preferences:

If you never work with Performances then you can exclude them from the bulk transfers by clearing
the Include Performances in Bulk Transfer checkbox

• 

If you wish for fs.factory to always read the FS1R Voice/Performances on startup then check the
Read FS1R MIDI Data on Startup checkbox

• 

If you wish for changes made to the FS1R Synthesizer Window to be automatically written to the
FS1R then check the Automatically Update FS1R after Synth Window Edit checkbox

• 

You can adjust how long that fs.factory will wait for a response from the FS1R by adjusting the
Timeout Delay value, which is given in milliseconds

• 

The Transmit Buffer Size, Transmit Delay Between Buffers and Transmit Delay Between Objects values
should not require adjustment. fs.factory sends data to the FS1R by dividing the data into packets the size of
which are specified by the Transmit Buffer Size value. When fs.factory sends a packet it waits for the time
period specified by Transmit Delay Between Buffers before sending the next packet, and it waits for the
time period specified by Transmit Delay Between Objects after the last packet is sent. The delay
parameters are specified in milliseconds. You may need to adjust these values (smaller buffers, longer
delays) if communications is not reliable, and you may if you wish adjust these values (larger buffers, smaller
delays) to maximise data transfer performance. If you adjust these values, please ensure that you test the
transfer to ensure it is reliable, otherwise you may risk losing data. Note: Some MIDI interfaces do not like
large packet sizes: I recently upgraded to a MOTU interface and ran into problems with MIDI export until I
altered fs.factory to send messages in small chunks defined by the above parameters!

Copying/Moving Voices and Performances

In operation, using MIDI is quite straightforward.

You can get all the FS1R Voices/Performances into any Child Window (including the FS1R Synthesizer
Window) by selecting the Import from MIDI option on the MIDI Menu, or the      button on the Tool Bar.

This imports all Voices, and all Performances if you have set the MIDI Preferences options to include
Performances during the bulk transfers into the selected window.

Similarly you can also export all Voices and Performances using the Export MIDI option on the MIDI Menu, or
the      button on the Tool Bar.

Note if you import or export MIDI data to/from a Child Window which is opened from a data file, then the FS1R
Synthesizer Window is also updated with the Voices/Performances being imported/exported.

And you can also move/copy Voices/Performances between the FS1R Synthesizer Window and Child
Window using drag and drop.

You can also import/export a Voice or Performance to/from the FS1R Edit Buffer by selecting a single
Voice/Performance and selecting the import/export to/from FS1R Edit Buffer options from the Voice's or
Performance's Context Sensitive Menu. You can also use the keyboard shortcuts for doing this.

If you wish to import a Voice from the FS1R edit buffers then the following dialog will appear, allowing you to
specify which Voice Edit Buffer to import from:
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Similarly, if you wish to export a Voice to the FS1R Edit Buffers then the following dialog will appear, allowing
you to specify which Voice Edit Buffer to export to:

Exporting Performances from fs.factory to the FS1R Edit Buffer is really handy, for example, when trying to
find a particular Performance in a file and you don't wish to load the whole file into the FS1R.

If you send a Performance to the FS1R then any user Voices required by the Performance are also copied
over to the FS1R Voice Edit Buffers.

Finally you can also perform all the operations on Voices/Performances in the FS1R Synthesizer Window that
you can upon Voices/Performances in a normal Child Window.

If you have the Automatically Update FS1R after Synth Window Edit option active, when you change data
the FS1R Synthesizer Window then the changes are automatically exported to the FS1R.

So you may wish to turn the Automatically Update FS1R after Synth Window Edit option off during
intensive editing sessions. Once you've made all your changes you then select the Export MIDI option on
the MIDI Menu, or the      button on the Tool Bar Export option to manually export the changes.

If you quit fs.factory with changes still present in the FS1R Synthesizer Window that have not been exported,
then you will be asked if you wish to export the data or not.

MIDI Keyboard Routing

fs.factory has a facility to allow MIDI data from an additional MIDI input port, defined in the MIDI
Preferences options dialog, to be routed to the port you have selected for fs.factory to output MIDI data on.
This allows, for example, you to use a master keyboard (which may be closer to your computer) to be used
when auditioning FS1r sounds that you've sent from fs.factory to the FS1r edit buffer.

You access this feature by selecting the FS1R MIDI Router ... option in the  MIDI Menu or by pressing the
F12 function key whenever you need it, which activates the following dialog.

The router uses the MIDI channel defined in the MIDI Preferences dialog This can either be the channel
transmitted by the source device, or the specified channel.

The routing is active until you close the dialog by selecting the Close Channel button or by pressing the ESC
key.
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Library Support
To use the fs.factory Library, your copy of fs.factory needs to be registered.

Configuring the Library

To configure the Library, go to the Library Preferences tab in the Preferences Dialog, and set up the
preferences for the Library.

Adding Objects to The Library

The following Objects can be added to the Library.

Synthesizer• 
Voices• 
Performances• 

You can add Objects to the Library using the following methods:

Use the Add To Library function that can be found in an Object's context menu;• 
Drag Copy an Object or Selection of Objects over the FS1R Library Window.• 
Using the copy and paste functions of the Clipboard.• 

Please note that you can only Drag Copy Objects to the FS1R Library Window; you cannot Drag Move them.

Referenced objects are also copied to the Library if they are not already present in the Library. For example, if
you copy a Performance and it references Voices then they are also copied if required.

If an object is copied to the Library and it is already present in the library (either a complete match or just a
match in name), then the actions you have configured in the Library Preferences tab in the Preferences Dialog
are taken.

You can also Batch Import files to the library

Copying Objects From The Library

You can copy Objects from the Library to a file using the following methods:

Drag Copy an Object or Selection of Objects from the the FS1R Library Window to a file.• 
Using the copy and paste functions of the Clipboard to copy an object from the FS1R Library Window
and paste it to a destination file.

• 

Referenced objects are also copied from the Library if they are not already present in the destination file and if
the destination file supports them. For example, if you copy a Performance and it references Voices then they
are also copied if required.

Deleting Objects From The Library

To delete an object from the library, right click over the Object or selection of Objects and select the Delete
option from the context menu

Exporting Voices and Performances From The Library to the FS1R

You can send Voices and Performances from the Library to the FS1R edit buffer by right clicking over a
selected object and selecting the Export to FS1R Edit Buffer option from the context menu.

You can also Drag Copy an Object or Selection of Objects from the the FS1R Library Window to the FS1R
Synth Window

Extracting Files from the Library

If you set the Library Table View to show Files, you can right click over a file and select the Extract File menu
option, which will recreate the original file from all the source data held in the database. The file can then be
saved. This option is also available for Files shown in the Library Tree View

List File Usage

If you right click over an object in the Library, and select the List File Usage... menu option, a dialog will be
displayed which shows all the files in the Library that make use of that object.

Several files may refer to a single object based on the setting on the Library import preferences if they are set
not to add identical objects. If this is set only a single copy is stored, and all files that contained the identical
object only refer to that single object within the Library
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New Author

If you set the Library Table View to show Authors, you can right click in the Table and select the New Author
menu option, which displays a dialog that allows you to create a new Author. This option is also available in
the Library Tree View by right clicking over the Author branch

Library Information ...

Opens the Library Statistics dialog.
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Find and Goto Facilities
Find Dialog

fs.factory supports the ability to find Objects by name.

Searches start from the currently selected Object.

Selecting the Find ... option on the Edit Menu brings up the Find dialog, that allows you to specify the string to
search for. In addition, there are several options that can be selected to help refine the search.

Find What The text string to search for.
Match Case If this option is checked then the search is case sensitive. If this option is not checked then

the search is case insensitive.
Match Whole
Name

If this option is checked then the search string must match the entire name of an Object.
E.g. "pan" would match a Voice called "pan", but not a Voice called "pandora". If this option
is not checked then the search can match a sub string within a name. E.g. "dor" would
match a Voice named "dor" and a Voice called "pandora".

Use Wild Cards If checked fs.factory will treat the "Find What" text as a "regular expression" to allow you
more control over the search, such as matching text at the start of a name, or the end of a
name, words with numbers in, etc.

The regular expression language used for fs.factory wild card support is the Perl Regular Expression Syntax.
Rather than try and write up this powerful syntax myself into the fs.factory documents, I'll direct you to the Perl
Regular Expression Syntax page for a description of how to use this powerful feature.

Find Category Dialog

You can also search by category be selecting Find Category ... option on the Edit Menu, which brings up the
Find Category Dialog.

This option allows you to search, for example, for all string Voices in a file.

Simply select the Category from the "Find Category" combo box that you wish to search for, and that's all
there is to it.
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Goto Dialog

Selecting this option on the on the Edit Menu brings up the Goto Dialog

Item Type The type of Object to go to

You can select either Voices or Performances in a Tree View.• 
If a Voice Table is the selected view, then you can only Goto another Voice.• 
If a Performance Table is the selected view, then you can only Goto another
Performance.

• 

Item Number The number of the Object to go to.
Note that Goto is not support in the FS1R Library Window.
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Editing Features
fs.factory supports the following editing features:

General Editing Features• 
Synth Editing Features• 
Voice Editing Features• 
Performance Editing Features• 
System Settings Editing Features• 
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General Editing Features

fs.factory supports many editing features, some of which are classed as general features that are applicable
to all or most Objects.

The general features are described here in one place for convenience:

Copy/Move Object• 
Initialise Object• 
Rename Object• 
Insert Object• 
Delete Object• 
List Object References• 
Sort Objects• 
Add Objects to Library• 

The following table shows whether or not a general edit operation can be applied to a particular type of
Object:

Object Type Move Copy Initialise Rename Insert Delete List Sort Add To
Library

Synth Object Y Y Y N N N N N Y
Voice
Collection

Y Y Y N N N N Y Y

Voice Y Y Y Y Y Y Y N Y
Voiced
Operator
Collection

Y Y Y N N N N N N

Voiced
Operator

Y Y Y N Y Y N N N

Unvoiced
Operator
Collection

Y Y Y N N N N N
N

Unvoiced
Operator Y Y Y N Y Y N N N

Performance
Collection

Y Y Y N N N N Y Y

Performance Y Y Y Y Y Y N N Y
Performance
Part
Collection

Y Y Y N N N N N
N

Performance
Part

N N Y N N N N N N

Performance
Effects
Collection

Y Y Y N N N N N
N

Performance
Reverb Unit Y Y Y N N N N N N

Performance
Variation
Effect Unit

Y Y Y N N N N N
N

Performance
Insert Effect
Unit

Y Y Y N N N N N
N

Performance
3 Band EQ
Unit

Y Y Y N N N N N
N

Performance
Controller
Collection

Y Y Y N N N N N N

Performance
Controller Y Y Y N Y Y N N N

Performance
Formant
Sequence

Y Y Y N N N N N
N

System
Parameters Y Y Y N N N N N N
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Copy/Move Object

fs.factory makes extensive use of drag and drop for copying and moving Objects.

You can drag copy or move Objects within a file or between files, and you can drag single items or multiple
items.

The default drag operation is to move an Object, and there are two types of move operations:

Moving an Object within its Parent Collection (e.g. moving a Voice from location 1 to location 4)• 
Moving an Object to a new Parent Collection (e.g. moving a Voice from one file to another file)• 

When you move an Object to a new Parent Collection then the original Object is removed and replaced with
an initialised Object of the same type.

To copy an Object using drag and drop, you must have the DRAG MODIFIER key held down during the
operation. The DRAG MODIFIER key is platform dependent. On the PC platform it is the CTRL key.

You can tell that a copy operation is in progress as the drag image icon has a + sign visible.

When you drag multiple items they must be of the same type. For example you can drag several Voices, but
not Voices and Performances together.

fs.factory provides the following drag/drop feedback to assist in determining the effects of a drag/drop
operation:

Cursor: Indicates if the move is either a copy or a move, or if the drop is invalid (e.g. trying to drag a
Voice onto an Element)

• 

Drag image: A simple pictorial representation of what is being dragged• 
Drop Point: fs.factory shows the drop point as either a cue line drawn between Objects if an Object is
being moved within its parent (e.g. an Operator within a Voice), or a cue rectangle drawn around the
drop location for all other moves and copy operations which are valid

• 

When a Child Window is split, Objects can be dragged and dropped between either side of the split point. This
is handy, for example, for dragging Objects between the start of a Collection and the end of a Collection.

The Tree and Table views will auto-scroll in drag and drop operations, when you move the cursor to either the
top or the bottom of the pane and hold it there.

If you drag an Object onto a Tree View and over a valid parent Object (e.g. an Operator over a Voice) and the
parent Object is collapsed within the Tree, and you hold the cursor over the Parent Object for a few seconds it
will automatically expand.

fs.factory will maintain the references to Voices in Performance Parts when moving Voices within a file.

For example if you move a Voice from Location 2 to Location 10, then any Performance Parts which are
referencing Voices at Locations 2 and above will be updated to ensure they still reference the same Voices
after the move operation as they were before the move operation.

The ability to update Voice references following a move or to copy referenced Voices during a move to a new
file can be selectively turned on or off within the Preferences Dialog.

Initialise Object

Initialises the selected Object to its default state.

Multiple Objects of the same type can be selected for initialisation.

The Initialise command is found upon the Context Sensitive Menu in both the Tree View and the Table
View.

Rename Object

Renames the selected Object using the following dialog, which can also be used to change the object
category:

Only one Object can be selected for renaming.
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The  Rename command is found upon the Context Sensitive Menu in the Tree View

To rename Objects in the Table View, simply double click in the Name Cell of the required Object to edit the
name.

Insert Object

Inserts an Object into a Collection at the current location.

The Insert command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can insert more than one Object at a time by selecting multiple Objects prior to executing the Insert
command.

For example if you wish to insert three Performances at location 10, select Performances 10, 11 and 12 and
then execute the Insert command.

Note that when you insert one or more Objects, then the commensurate number of Objects at the end of the
Parent Collection are removed if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, an FS1R Voice Collection can only contain 128 Voices, so if two Voices are inserted into the
Collection then two Voices must be removed from the end of the Collection to maintain the correct size.

fs.factory will maintain the Performance Part references to Voices when inserting Voices.

For example if you insert a Voice into a file at Location 10, then any Performance Parts which are referencing
Voices at Locations 10 and above will be updated to ensure they still reference the same Voices after the
insert operation as they were before the insert operation.

Delete Object

Deletes an Object at the current location.

The Delete command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can delete more than one Object at a time by selecting multiple Objects prior to executing the Delete
command.

For example if you wish to delete three Performances at location 10, select Performances 10, 11 and 12 and
then execute the Delete command.

Note that when you delete one or more Objects, then a commensurate number of Objects at the end of the
Parent Collection are added if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, an FS1R Voice Collection must contain 128 Voices, so if two Voices are deleted from the
Collection then two Voices must be added to the end of the Collection to maintain the correct size.

fs.factory will maintain Performance Part references to Voices in a Collection when deleting Voices.

For example if you delete a Voice from a SYSEX file at Location 10, then any Performance Parts which are
referencing Voices at Locations 10 and above will be updated to ensure they still reference the same Voices
after the delete operation as they were before the delete operation.

List Object References

The List References command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

The List References command is only available if:

Only one Voice is selected• 
The Voice selected is referenced by a Performance, which is indicated by the Voice being coloured
blue

• 

The references are shown as follows:
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The Voice being referenced is shown at the top of the Dialog followed by the Performances referencing it.

Sort Objects

The  Sort by Name and Sort By Category commands are found upon the Context Sensitive Menu in both
the Tree View and the Table View.

In the Tree View the sort options are accessed via the Context Sensitive Menu for the Collection that you
wish to sort (e.g. the Voice Collection to sort Voices).

In the Table View the sort options are accessed via the Context Sensitive Menu for any Object. The sort can
also be initiated by clicking in the Name or the Category column headers.

 Program Features 46



Synth Editing Features

fs.factory supports the following editing operations upon the Synth Object within the Tree View of a Child
Window:

Move• 
Copy• 
Initialise• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access these features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Synth Object to activate the Synth Object's Context Sensitive Menu.

The Synth Object is only shown within a Tree View and is the first Object in the Tree View. It is called:

SYSEX File
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Voice Editing Features

fs.factory supports the following editing operations upon the Voice Collection shown within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Import Data From FS1R• 
Export Data to FS1R (only available if fs.factory is registered)• 
Import Data from FS1R by Manual Dump...• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Voice Collection Object in file is only shown within a Tree View and is called User Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Collection to activate the Voice Collection's Context Sensitive Menu.

fs.factory supports the following editing operations upon the Voice Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from FS1R Memory• 
Export to FS1R Memory (only if available fs.factory is registered)• 
Import from FS1R Edit Buffer• 
Export to FS1R Edit Buffer (only if available fs.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
or selection of Voices to activate the Voice's Context Sensitive Menu.

You can also directly edit the Voiced Operators

You can also directly edit the Unvoiced Operators

Import from FS1R Memory

Imports Voices from the FS1R Memory locations into the currently selected Child Window.

You can import:

A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 

Export to FS1R Memory

Exports Voices from the currently selected Child Window to the FS1R Memory locations.

You can export:

A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 

Import from FS1R Memory by Manual Dump

Imports Voices from the FS1R Memory locations into the currently selected Child Window using the manual
bulk dump features of the FS1R.

This option has been added because the BULK dump of voices and performances from the FS1R panel is
about 12 times faster than fs.factory requesting each Voice/Performance. For some reason, the FS1R
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enforces delay of three seconds after each operation even though the transfer takes less than a second. This
significantly slows down a transfer

When you select this option, the following dialog is shown.

fs.factory is now waiting for you to initiate the BULK DUMP from the FS1R. If required you can press the
CANCEL button to cancel the dump.

to initiate the BULK DUMP, follow the instructions below using the buttons on the FS1R front panel.

Press the UTIL button.• 
Use the CURSOR buttons to select the DUMPOUT option and press the ENTER button.• 
Use the CURSOR buttons to select the Voice option and press the ENTER button.• 
You will now see a flashing all in the right of the display. Press the ENTER button to initiate the bulk
dump or the EXIT button to cancel.

• 

Once data is being transmitted by the FS1R, fs.factory will show the progress in the dialog box as shown
below. Whilst the FS1R will transmit all data until it is finished, if you wish you can cancel the download in
fs.factory.

Once all data has been transmitted, press the OK button to import the data into the current file (or synth
window) or press the CANCEL button to cancel the import.

If you requested the import of Voices, but inadvertently transmitted Performances from the FS1R, then the
following error dialog is shown.

Import from FS1R Edit Buffer

Imports the Voice currently in an FS1R Voice Edit Buffer into the Voice currently selected within the
active Child Window.

When you select this option, the following dialog will appear, allowing you to specify which voice edit buffer to
import from:

Note if you have more than one Voice selected then this operation is not available
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Export to FS1R Edit Buffer

Exports the Voice currently selected within the active Child Window to an FS1R Voice Edit Buffer.

When you select this option, the following dialog will appear, allowing you to specify which Voice Edit Buffer to
export to:

Note if you have more than one Voice selected then this operation is not available

Voiced Operator Editing Features

fs.factory supports the following editing operations upon the Voiced Operator Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voiced Operator Collection to activate the Voiced Operator Collection's Context Sensitive Menu.

fs.factory supports the following editing operations upon the Voiced Operator Objects within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Voiced Operator or selection of Voiced Operators to activate the Voiced Operator's Context Sensitive
Menu.

Unvoiced Operator Editing Features

fs.factory supports the following editing operations upon the Unvoiced Operator Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Unvoiced Operator Collection to activate the Unvoiced Operator Collection's Context Sensitive Menu.

fs.factory supports the following editing operations upon the Unvoiced Operator Objects within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Unvoiced Operator or selection of Unvoiced Operators to activate the Unvoiced Operator's Context
Sensitive Menu.
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Performance Editing Features

fs.factory supports the following editing operations upon the Performance Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Import Data from FS1R• 
Export Data to FS1R (only available if fs.factory is registered)• 
Import Data from FS1R by Manual Dump...• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Performance Collection Object in a file is only shown within a Tree View and is called User
Performances.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Collection to activate the Performance Collection's Context Sensitive Menu.

fs.factory supports the following editing operations upon the Performance Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Import from FS1R Memory• 
Export to FS1R Memory (only if available fs.factory is registered)• 
Import from FS1R Edit Buffer• 
Export to FS1R Edit Buffer (only if available fs.factory is registered)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance or selection of Performance to activate the Performance's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a
Performance:

Performance Parts• 
Performance Effects• 
Performance Controllers• 
Performance Formant Sequence• 

Import from FS1R Memory

Imports Performances from the FS1R Memory locations into the currently selected Child Window.

You can export:

A Single Performance• 
A Selection of Performances• 
All Performances by selecting the Performance Collection• 

Export to FS1R Memory

Exports Performances from the currently selected Child Window to the FS1R Memory locations.

Import from FS1R Memory by Manual Dump

Imports Performances from the FS1R Memory locations into the currently selected Child Window using the
manual bulk dump features of the FS1R.

This option has been added because the BULK dump of voices and performances from the FS1R panel is
about 12 times faster than fs.factory requesting each Voice/Performance. For some reason, the FS1R
enforces delay of three seconds after each operation even though the transfer takes less than a second. This
significantly slows down a transfer
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When you select this option, the following dialog is shown.

fs.factory is now waiting for you to initiate the BULK DUMP from the FS1R. If required you can press the
CANCEL button to cancel the dump.

to initiate the BULK DUMP, follow the instructions below using the buttons on the FS1R front panel.

Press the UTIL button.• 
Use the CURSOR buttons to select the DUMPOUT option and press the ENTER button.• 
Use the CURSOR buttons to select the Perform option and press the ENTER button.• 
You will now see a flashing all in the right of the display. Press the ENTER button to initiate the bulk
dump or the EXIT button to cancel.

• 

Once data is being transmitted by the FS1R, fs.factory will show the progress in the dialog box as shown
below. Whilst the FS1R will transmit all data until it is finished, if you wish you can cancel the download in
fs.factory.

Once all data has been transmitted, press the OK button to import the data into the current file (or synth
window) or press the CANCEL button to cancel the import.

If you requested the import of Performances, but inadvertently transmitted Voices from the FS1R, then the
following error dialog is shown.

Import from FS1R Edit Buffer

Imports the Performance currently in the FS1R Edit Buffer (i.e. the currently selected Performance on the
FS1R) to the Performance currently selected within the active Child Window.

Note if you have more than one Performance selected then this operation is not available

Export to FS1R Edit Buffer

Exports the Performance currently selected within the active Child Window to the FS1R Edit Buffer.

Note if you have more than one Performance selected then this operation is not available

Performance Part Editing Features

fs.factory supports the following editing operations upon the Performance Part Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over
thePerformance Part Collection to activate the Performance Part Collection's Context Sensitive Menu.

fs.factory supports the following editing operations upon the Performance Part Objects within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Set Voice• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Copy, Move and Set Voice (which you do via "Drag and Drop"), right click
over a Performance Part or selection of Performance Parts to activate the Performance Part's Context
Sensitive Menu.

Set Voice

A User Voice from the same file can be dragged onto a Performance Part to set the Voice used by the
Performance Part.

Preset Voices from the FS1R Synthesizer Window can be dragged onto Performance Parts as well.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Performance Part.
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Performance Effects Editing Features

fs.factory supports the following editing operations upon the Performance Effects Units Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Effects Units Collection to activate the Performance Effects Units Collection's Context
Sensitive Menu.

fs.factory supports the following editing operations upon the individual Performance Effects Objects
(Reverb, Variation, Insertion and EQ effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance Effect or selection of Performance Effects to activate the Performance Effects's Context
Sensitive Menu.

Performance Controller Editing Features

fs.factory supports the following editing operations upon the Performance Controllers Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Performance Controllers Collection Object is only shown within a Tree View and is called Controllers.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Controllers Collection to activate the Performance Controllers Collection's Context
Sensitive Menu.

fs.factory supports the following editing operations upon the Performance Controller Objects within the Tree
View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance Controller or selection of Performance Controllers to activate the Performance Controller's
Context Sensitive Menu.

Performance Formant Sequence Editing Features

fs.factory supports the following editing operations upon a Performance Formant Sequence shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Performance Formant Sequence Object is only shown within a Tree View and is called Formant
Sequence.
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Formant Sequence to activate the Performance Formant Sequence's Context Sensitive
Menu.

System Settings Editing Features

fs.factory supports the following editing operations upon the System Settings Object shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The System Settings Object is only shown within a Tree View and is called System Settings.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
System Settings Object to activate its Context Sensitive Menu.
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Master Patch List

The Master Patch List Dialog is found on the Tools menu.

This feature is only available if your copy of fs.factory is registered.

The Master Patch List Dialog provides a means for you to generate a single patch list from a list of files.
Currently only Cubase Patch Scripts can be generated, but future versions may support other sequencers.

The Master Patch List dialog is shown below:

This dialog has the following options:

File List The list of files to incorporate into a single patch list.

If you click on one of the lines then you can edit the file either by typing
or by using the [...] button to the right of the line to bring up a file selector
dialog.

Note, if you are editing a line, and you are finished, you need to select
another line, or press the RETURN key for the changes to be stored.

New Inserts a new line in the file list.
Delete Deletes the currently selected line in the file list. If no line is selected this

control is disabled.
Move Up Moves the currently selected line in the file list up one line. If no line is

selected or the selected line is the first in the list then this control is
disabled.

Move Down Moves the currently selected line in the file list down one line. If no line is
selected or the selected line is the last in the list then this control is
disabled.

Sort Sorts the lines into ascending alphabetical order
Cubase Exports the files identified in the file list to a Cubase format patch script

file, which is compatible with Cubase VST/SX/SL/SE.
Include Preset Data When this option is checked, the FS1R Preset Performances are

exported at the start of the patch list.
OK Closes the dialog.
Generating The Cubase Master Patch List

When you generate a Cubase Patch Script, it is written to the directory specified by the Cubase Patch Script
Directory field in the  Misc Preferences Tab of the  Preferences Dialog. You can set this field up to export the
master patch list directly to the directory read by Cubase upon startup. This directory on my system is
C:\Documents and Settings\Derek\Application Data\Steinberg\Cubase SX
3\Scripts\Patchnames\inactive\yamaha where "C:" is the root drive that Cubase is installed on, "Derek" is
my Windows user name, and "Cubase SX 3" is my version of Cubase. You will need to vary these according
to your system drive and of course your own user name and version of Cubase.
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By default the Application Data folder is hidden in Windows Explorer, so you may not see this folder first of
all. If you cannot see the folder:

In Windows Explorer select Folder Options from the Tools menu and click the View tab.1. 
Look down the Advanced Settings list and find the Hidden Files and Folders option.2. 
Select the Show Hidden Files and Folders sub option.3. 
Select OK to close the dialog.4. 

Cubase only looks for and reads patch scripts when it starts up, so if you're in Cubase after generating the
patch script then exit Cubase and start it up again.

Configuring Cubase to Use the Master Patch List

The patch scripts generated by fs.factory should be compatible with Cubase VST/SX/SL/SE. The instructions
given below are for Cubase SX, which is the version I use. Consult your Cubase documentation for how to
install patch scripts if you have a different version.

Within Cubase:

Select MIDI Device Manager from the Devices Menu.1. 
Click on the Install Device button.2. 
Click on the FS1R - Master Patch List option (this is the fs.factory generated file). At the bottom of
this dialog, select your output MIDI port that the FS1R is connected to. You can now close this dialog.
If you cannot see the FS1R - Master Patch List then you have not placed it in the right folder.

3. 

This installs the patch list within Cubase and allows you to use it elsewhere within the application.

In the main Cubase screen, select or create a MIDI track that you wish to be used with the FS1R. In the
Inspector window (the panel to the left of the main window) click on the out control and you should now be
able to see and select the FS1R - Master Patch List option in amongst the MIDI ports. Also ensure the MIDI
channel number for the track matches the FS1R channel number.

Now when you click in the Programs control, just below the out control, you'll see a drop down list containing
all of the FS1R Voices names generated by fs.factory.

You can now scroll through the lists to find a Voice, an you can also type in filter text to quickly look for a
Voice.

Library Statistics

The Library Statistics menu option is found on the Tools menu.

This feature is only available if your copy of fs.factory is registered.

The Library Statistics Dialog provides a means for you to see a summary of the contents of the Library.

Batch Import To Library

The Batch Import To Library Wizard is found on the Tools menu.

This feature is only available if your copy of fs.factory is registered.

The Batch Import To Library Wizard provides a means for you to import several FS1R files to the library in one
go.

The Batch Import To Library Wizard has two pages to navigate through:
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The Select Source Directory Page• 
The Select Destination Directory Page• 

Select Source Directory Page

The Select Source Directory Page is shown below

This page has the following options

Source Directory You can type the name of the source directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Scan Subdirectories If this control is checked, then the Batch Converter will also include any
subdirectories that it finds within the source directory when looking for
files to convert.

If this control is not checked then any subdirectories in the source
directory will be ignored.

Ignore File Errors If this control is not checked then any errors detected during file loading
will halt the conversion process.

If this control is checked then these errors are ignored, but are logged if
logging is enabled.

Select Destination Directory Page

The Select Destination Directory Page is shown below

This page has the following options

When an Object being added is
already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
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Do not add to Library• 
Overwrite Object in the Library• 

When an Object being added
already has the same name as an
Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 

Create Log File If this control is checked then a log file is created in the destination
directory.

This log file is called "Log File.txt", and can be opened with any text
editor

Using the Batch Importer

Using the importer is quite simple.

Importing an FS1R file takes about 20 seconds, so if you have a lot of files to import, be prepared to leave the
importer running for a while!

The importer is a simple "Wizard" and you can step through the choice pages using the Prev and Next
buttons, or exit the Wizard using the Cancel Button

Select the source and destination directory options and once that is done click on the Finish button to start
the Batch Import Wizard.

The Wizard will not allow you to select a directory that doesn't exist.

Once the Wizard starts the progress of importing files is shown in the information pane.

There is a progress bar that shows the progress for all the files that the importer has detected, and a progress
bar for the objects in the file currently being imported.

The Wizard also shows how many file errors have been encountered (assuming you have set the options to
ignore File errors).

You can cancel the import at any time by pressing the Cancel button, but you may need to wait for fs.factory
to finish the current file import before the batch conversion is cancelled.

Once completed, a summary results page is shown that summarises the import.
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The Wizard can be dismissed by clicking the Close button.

You can check the results of the import by opening the Log File.txt file (assuming you left logging enabled).

The log file is a simple text file that lists each source file and whether any errors were detected.

All errors are preceded by ** (two stars), so you can use your text editor's find/search facilities to look for ** to
quickly find any errors.

Batch Import DX7 Files

The Batch Import DX7 Files Wizard is found on the Tools menu.

This feature is only available if your copy of fs.factory is registered.

The Batch Import DX7 Files Wizard provides a means for you to import several DX7 SYSEX files and convert
them to FS1R SYSEX files.

The Batch Import DX7 Files Wizard has two pages to navigate through:

The Select Source Directory Page• 
The Select Destination Directory Page• 

Select Source Directory Page

The Select Source Directory Page is shown below

This page has the following options

Source Directory You can type the name of the source directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Scan Subdirectories
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If this control is checked, then the Batch Converter will also include any
subdirectories that it finds within the source directory when looking for
files to convert.

If this control is not checked then any subdirectories in the source
directory will be ignored.

Ignore File CRC Errors If this control is not checked then any errors detected during file loading
will halt the conversion process.

If this control is checked then these errors are ignored, but are logged if
logging is enabled.

It's recommended that this option is set, as there are many DX7 files on
the Internet with checksum errors

Select Destination Directory Page

The Select Destination Directory Page is shown below

This page has the following options

Destination Directory You can type the name of the destination directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Ignore MIDI Errors If this control is not checked then any MIDI errors detected during
conversion will halt the conversion process.

If this control is checked then these errors are ignored, but logged if
logging is enabled.

Create Log File If this control is checked then a log file is created in the destination
directory.

This log file is called "Log File.txt", and can be opened with any text
editor

Using the Batch Importer

Using the importer is quite simple, but note that your FS1R must be connected and correctly set up before use
as the converter works by sending a DX7 voice to the FS1R and reading the voice back in FS1R format from
the FS1R edit buffer.

Converting a file of 32 DX7 voices takes about 3 minutes, so if you have a lot of files to convert, be prepared
to leave the converter running for a while!

The converter is a simple "Wizard" and you can step through the choice pages using the Prev and Next
buttons, or exit the Wizard using the Cancel Button

Select the source and destination directory options and once that is done click on the Finish button to start
the Batch Import Wizard.

The Wizard will not allow you to select a directory that doesn't exist, and the source and destination
directories must be different to prevent you from accidentally overwriting the source DX7 files.

Once the Wizard starts the progress of converting files is shown in the information pane.
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There is a progress bar that shows the progress for all the files that the importer has detected, and a progress
bar for the voices in the file currently being converted.

The Wizard also shows how many file CRC and MIDI errors have been encountered (assuming you have set
the options to ignore File and MIDI errors).

You can cancel the conversion at any time by pressing the Cancel button, but you may need to wait for
fs.factory to finish the current conversion before the batch conversion is cancelled.

Once completed, a summary results page is shown that summarises the conversion.

The Wizard can be dismissed by clicking the Close button.

You can check the results of the conversion by opening the Log File.txt file (assuming you left logging
enabled).

The log file is a simple text file that lists each source file and whether any errors were detected.

All errors are preceded by ** (two stars), so you can use your text editors find/search facilities to look for ** to
quickly find any errors.
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Preferences
The fs.factory preferences are accessed via the View menu Preferences ... option, or the  button on
the Toolbar.

Selecting this option opens a Tabbed dialog with the following tabs which group related parameters:

Performance Preferences• 
Check Preferences• 
Default View Preferences• 
MIDI Preferences• 
Library Preferences• 
Miscellaneous Preferences• 

To view and modify a set of parameters, click on the relevant tab.

Note: The options to update Performances following a Voice move within the same file also apply when
Voices are inserted, deleted and sorted.

Note: The options to copy referenced Voices with "parent" Performances work by:

Checking the destination file to see if the referenced Voice exists• 
If it does then the parent Performance is updated after being moved to point to the existing Voice in
the destination file

• 

If not then fs.factory checks to see if a blank or empty Voice is present in the destination file• 
If a blank Voice is found then the child Voice is moved or copied and the parent Voice is updated after
being moved to point to the new Voice in the destination file

• 

If no blank Voice is found the fs.factory gives up. Note this may result in a Partial edit (e.g. it may
have only been possible to copy a subset of Performances due to the amount of free Voices in the
destination file)

• 

The Voices are only ever copied irrespective of whether the parent Performance is being moved or
copied. This is to avoid the problem that would occur when a Voice is moved, where the source Voice
(which would have been initialised after the move) is also referenced by other Performances

• 
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Performance Preferences
The Performance Preferences tab is shown below:

This tab has the following options:

Update Performances/Parts After
Voice Move

If you move a Voice within an SYSEX file then the Performances and
their Parts are updated to ensure that the correct references to User
Voices are maintained.

Copy User Voices With
Performance

If you move or copy a Performance from an SYSEX file to another
SYSEX file, then any User Voices referenced by the Performance and its
Parts are also copied to the destination file if the Voices are not already
present in the destination file.
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Check Preferences
The Check Preferences tab is shown below:

This tab has the following options:

Check For Duplicates When
Moving or Copying Objects

If you move or copy an Object to a destination file and the Object already
exists then a warning is presented giving you the option to continue or
cancel the operation.

Warn if Destination Object is
Referenced When Moving or
Copying Objects

If you move or copy an Object and it is overwriting an Object that is
being referenced, or you are deleting a referenced Object, then a
warning is presented giving you the option to continue or cancel the
operation.
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Default View Preferences
The Default View Preferences tab is shown below:

Default View Defines the type of view that is applied to a Child Window when it is first
opened.

The following options are available:

No Split• 
Horizontal Split• 
Vertical Split• 

Pane/Left Pane/Top Pane Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

Tree View• 
Table View• 

Right Pane/Bottom Pane This control is only visible if the Default View option is set to either
Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 

View Tool Bar Controls if the toolbar is visible at startup.
View Status Bar Controls if the status bar is visible at startup.
View Backdrop In Child Window This option controls if the image backdrop is displayed in Child Windows.

You may wish to turn off this option if you find the scrolling of the Child
Window is slow on your machine.
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MIDI Preferences
The MIDI Preferences tab is shown below:

This tab has the following options:

Keyboard Input MIDI
Port

Sets the port used for accepting MIDI data from a keyboard and routing it to the
output MIDI port using the MIDI Router Dialog.

Keyboard Input MIDI
Channel

Sets the channel to be used for transmitting MIDI data using the MIDI Router
Dialog. The first option Use Source Channel in the drop down list, means that the
MIDI channel from the source device is not altered.

Input MIDI Port Sets the port used for MIDI input from the available ports.
Output MIDI Port Sets the port used for MIDI output from the available ports.
SYSEX Device Number Sets the SYSEX device number used for SYSEX transfers. This must match the

Device No value set in the FS1R's MIDI pages. If the FS1R Device No is set to
all then it will receive all FS1R SYSEX messages irrespective of the device
number in the message.

Timeout Delay Sets the time that fs.factory waits for a response from the FS1R before timing out
and reporting an error. The value is specified in milliseconds.

Transmit Buffer Size Sets the size of the transmit buffer used for sending data to the FS1R. Some MIDI
interfaces don't like data coming in big chunks and you may need to set this to get
a reliable transfer of data. The value is specified in milliseconds.

Transmit Delay Between
Buffers

This sets the delay that fs.factory waits for between sending buffer sized data
packets. The value is specified in milliseconds.

Transmit Delay Between
Objects

This sets the delay that fs.factory waits for after sending a complete object. The
value is specified in milliseconds.

Automatically Update
FS1R after Synth
Window Edit

When this option is checked, if the FS1R Synthesizer Window is edited then the
edited data will be automatically sent to the FS1R.

Read FS1R MIDI Data On
fs.factory Startup

When this option is checked the Voices and Performances (if enabled) are read
from the FS1R during the fs.factory startup phase.

Include Performances In
Bulk Transfer

When this option is checked, the Performances are included in bulk transfers. You
may wish to uncheck this option if you don't use Performances.

Test FS1R MIDI Settings Tests to see if MIDI communications is working using the specified values.
The Transmit Buffer Size, Transmit Delay Between Buffers and Transmit Delay Between Objects values
should not require adjustment. fs.factory sends data to the FS1R by dividing the data into packets the size of
which are specified by the Transmit Buffer Size value. When fs.factory sends a packet it waits for the time
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period specified by Transmit Delay Between Buffers before sending the next packet, and it waits for the
time period specified by Transmit Delay Between Objects after the last packet is sent. The delay
parameters are specified in milliseconds. You may need to adjust these values (smaller buffers, longer
delays) if communications is not reliable, and you may if you wish adjust these values (larger buffers, smaller
delays) to maximise data transfer performance. If you adjust these values, please ensure that you test the
transfer to ensure it is reliable, otherwise you may risk losing data. Note: Some MIDI interfaces do not like
large packet sizes: I recently upgraded to a MOTU interface and ran into problems with MIDI export until I
altered fs.factory to send messages in small chunks defined by the above parameters!
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Library Preferences
The Library Preferences tab is shown below:

This tab has the following options:

When an Object being added is
already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

When an Object being added
already has the same name as an
Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

Copy Referenced Objects to
Library

If this Option is checked, then any Objects being referenced by an
Object being added to the Library are also added to the Library.

Prompt for Author of File When
Adding a File

If this Option is checked then fs.factory will ask for the Author of the file if
one has not already been entered.

Default Filter for Rating Column Sets the default filter type for the Rating column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 
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Default Filter for the Comment
Column

Sets the default filter type for the Comment column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Author
Column

Sets the default filter type for the Author column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Source
Column

Sets the default filter type for the Source column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

 Preferences 71



Miscellaneous Preferences
The Miscellaneous Preferences tab is shown below:

This tab has the following options:

Startup Directory Allows the startup directory to be specified. Note: no validation is
performed on this pathname, so please ensure it is valid. I may add
validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Cubase Patch Script Directory

Specifies the directory where Cubase patch scripts are written. Note: no
validation is performed on this pathname, so please ensure it is valid. I
may add validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Load Last File On Startup Controls if the last file opened in the previous session is automatically
loaded when dx.factory is next invoked.

User Formant Sequences If this is checked, then fs.factory will only send and receive the first 64
User Voices to/from the FS1R.

Create System in New Files If this is checked, then fs.factory will create a System Settings node in
new files when they are created.
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Online Help
fs.factory provides a full online version of the fs.factory manual.

If you select Help ... from the Help Menu or the   button on the Tool Bar, the Help Window is opened.

The Help Window works just like a web browser window, so its operation should be quite familiar to you.

The left pane of the Help Window shows a tabbed navigation pane to allow you to quickly navigate to a topic,
whilst the right hand pane shows the help topic.

The navigation pane can show three different views, depending on which tab you select:

    Displays the Table of Contents Navigation Pane, providing a structured list of fs.factory topics• 
    Displays the Index Navigation Pane, providing an indexed list of fs.factory topics• 
    Displays the Search Navigation Pane, allowing you to search the help topics for keywords• 

The Help Window has the following Tool Bar buttons:

    Navigates backwards to the last page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Navigates forwards to the next page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Selects the home page• 
    Refreshes the current page• 
    Prints the current page• 
    Displays the print settings dialog• 
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Context Sensitive Help
You can access context sensitive help by:

pressing the your Computer Platform's Help Key ( F1 on the PC platform), which will load the help
page associated with the Component within the fs.factory Window that currently has Focus (is
responding to the keyboard and mouse).

• 

pressing the  button on the Tool Bar and the clicking over the item of interest• 

You can press the Help Key in any fs.factory Dialog to access the relevant help page for the Dialog.
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Tips and Tricks
The fs.factory tips and tricks dialog is shown below:

This dialog has the following controls:

Close Closes the Tips and Tricks Dialog
Next Tip Selects the next tip in sequence
Show Tips at
Startup

If checked then when fs.factory starts up, the Tips and Tricks Dialog is automatically
opened

List of Tips and Tricks
Just in case you want the tips and tricks shown by the dialog as one single list, here they are.

Double Clicking a voice

If you double click a voice in a file or the library, it will be sent to the synth's edit buffer. If you triple click
instead, the MIDI Router dialog will be opened after the voice is sent to the synth's edit buffer.

Library Support

fs.factory provides a Library facility that allows you to store all your data in one place, and use filtering and
sorting facilities to locate the data that you want.

(NOTE: Library features are available only to registered users).

MIDI Support

fs.factory supports the transfer of Voices and Performances between fs.factory and the FS1R via MIDI.

(NOTE: The MIDI export features are available only to registered users).

Context Sensitive Help

If you press the Help Key ( F1 on a PC) then you can get context sensitive help, including within Dialogs.

Keyboard Shortcuts

fs.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the fs.factory manual for details of the supported keyboard shortcuts

Object Colouring

If a Voice is coloured blue, then it is being referenced by a Performance.

If you right click over a blue Voice you'll find a "List References" context menu item, which will show you the
Performances that reference this Voice.

Table Sorting

You can sort Voice and Performance Tables by name by clicking in the Table Name Column header, and they
can be sorted by category by clicking in the Table Category column header.
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DX7/DX7II Data Import

Registered users can import DX7 and DX7II data into fs.factory. Note that some DX7II voices may not sound
exactly the same as not all additional DX7II voice parameters are supported by the FS1R.

You can only DRAG COPY Certain Objects

If you are trying to perform a drag operation of a Voice onto a Performance Part and are wondering why
fs.factory is not allowing you to perform the drag, you must be holding down the CTRL key during the drag.
Holding down the CTRL key turns the operation from a Drag Move operation to a Drag Copy operation.

Sometimes during a drag operation, the only sensible operation that can be undertaken is a copy operation.

Copying/Moving Performances to a Different File

When you copy a Performance to a different file then any Voices it references can also be copied at the same
time.

I think you'll agree this is a cool feature!

This feature can be off if required within the Preferences Dialog.

MIDI Router

Press the F12 key and you get a "MIDI Router" popping up which, whilst active, will route MIDI data form the
Keyboard MIDI Port through to the Motif Output MIDI Port. This allows you to have the USB connection
selected on the Motif, whilst allow you to play data coming from a standard MIDI interface.

Master Patch List

The Master Patch List dialog under the Tools menu allows you to define a list of files that are exported,
along with preset voice definitions, as a master patch list for use in supported sequencers to select patches.
Currently only Cubase VST/SX/SE/SL patch lists are supported.

Workspaces

fs.factory allows you to save a Window arrangement as a Workspace which you can then recall at a later
date.

Moving Voices within a File

When you move a Voice within a file then any Performances that reference the Voice being moved can be
updated to ensure they all still reference the correct Voices after the move.

I think you'll agree this is a cool feature!

This feature can be off if required within the Preferences Dialog.

The FS1R Synthesizer Window

fs.factory has a special window called the FS1R Synthesizer Window. This is a special window that
represents the FS1R synthesizer itself.

By setting up the MIDI preferences settings you can:

Automatically import data from the FS1R synth into this FS1R Synthesizer Window when fs.factory
starts up

• 

Automatically export data from the FS1R Synthesizer Window to the FS1R Synth when the data in the
FS1R Synthesizer Window is edited

• 

Exporting Cubase/Protools Patch Lists

You can export Patch lists from SYSEX files for use within either Cubase VST, Protools or Sonar.

The relevant options can be found on the File Menu under the Export option

The Number After An Operator

In the Tree View you may notice that an operator has a number included after it in brackets. This number is
the "checksum" value associated with the operator, and is included as a signature and as a simple way of
distinguishing between operators.
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Exporting Files to MIDI

You can export a file directly to MIDI once it is opened. If you do this, then the data being exported is also
copied to the FS1R Synthesizer Window.

Importing Files from MIDI

You can import directly from MIDI into a file. If you do this, then the data being imported is also copied to the
FS1R Synthesizer Window.
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About fs.factory
The about dialog is shown when the About ... option from the Help Menu or the  button on the Tool Bar is
selected.

The dialog shows some basic information about the program including the version number and the License
status of fs.factory.

It also shows which Java Run Time Environment that fs.factory is running in.

It's also a chance to take a close look at the excellent Splash Graphic provided by Torus!
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Glossary
Term Definition
Child Window A window associated with an FS1R data file that you have opened that is used to

display the contents of the file.

Several Child Windows can be open within the fs.factory Desktop.
Clipboard A temporary storage area used for transferring data within a Child Window or

between Child Windows.
Collection A group of similar and related Objects.

For example a Voice Collection stores the 128 Voice Objects that a file can
contain

Context Sensitive Help The ability of the help system to tailor the help being displayed according to where
the user pressed the Help key.

Context Sensitive Menu The popup menu that is displayed in either the Tree View or Table View that
provides a set of commands specific to the currently selected Object

Desktop The area within the fs.factory window where Child Windows can be opened
Drag and Drop The name for the mechanism that allows a use to move data by dragging it with a

mouse and dropping it at a new location.
DRAG MODIFIER The keyboard key that is held down to turn a Drag and Drop move operation into a

copy operation.

On the PC platform, the DRAG MODIFIER key is the CTRL (control) key
FS1R Library Window A special instance of a Child Window that doesn't display data in a file, but which

displays the data stored in the FS1R Library.
FS1R Synthesizer
Window

A special instance of a Child Window that doesn't display data in a file, but which
displays User data imported from the FS1R via MIDI

JRE Java Run-time Environment. This provides the Java environment which fs.factory
needs in order to run.

Sun Microsystems provides the JRE for PC systems, and Apple provide their own
JRE for MacOS X

Library A repository where you can store all of your data.
MDI Multiple Document Interface. The type of user interface used by fs.factory which

allows several Windows to be open within the main application window.
Menu Bar The area of the fs.factory Window that contains the set of menus used for accessing

the main functions provided by the application.
MIDI Musical Instrument Digital Interface. The primary means by which digital data is

exchanged in a serial form between synthesizers and computers.
MMJ A MacOS X specific library that provides the means by which external MIDI devices

can be accessed with the Java MIDI framework.
Object A piece of FS1R data such as a Voice or Performance.
Reference The means by which the FS1R associates an Object (such as a Voice) with another

Object (such as a Performance Part). The reference provides the link between the
two, and in the case of the FS1R, the link is simply the number of the referenced
Object.

Regular Expression A system by which certain character sequences are interpreted not as plain text but
as commands that can provide a tailored search for occurrences of text

Status Bar The area of the fs.factory Window that is used to display status information upon the
currently selected Child Window. 

Table View A View which displays data in a file arranged in tabulated rows of data
Tool Bar The area of the fs.factory Window that contains a set of buttons to provide easy

access to commonly used commands
Tree View A View which displays data in a file arranged in a hierarchical tree structure.
View The means by which the data in a file is viewed.

A Child Window provides the view upon an FS1R File that you have opened.

The view can be either a Tree View or a Table View.

You can have several views open upon the same data, for example when you have
split a Child Window.

Workspace An arrangement of the main fs.factory Window and Child Windows which can be
saved for subsequent recall.
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Keyboard Short Cuts
fs.factory provides many keyboard shortcuts for navigation and performing editing operations.

In general, navigating between components uses these keys:

Tab. Moves keyboard focus to the next component or to the first member of the next group of
components.

• 

Ctrl-Tab. Moves keyboard focus to the next component or to the first member of a group of
components when the current component accepts a tab (as in text fields, tables, and tabbed panes).

• 

Shift-Tab. Moves keyboard focus to the previous component or to the first component in the previous
group of components.

• 

Arrow keys. Move keyboard focus within the individual components of a group of components--for
example, within menu items in a menu or within tabs in a tabbed pane.

• 

The shortcuts are divided into the following categories:

Keyboard shortcuts for the Desktop and Child Windows• 
Keyboard shortcuts for Tree Views• 
Keyboard shortcuts for Table Views• 
Keyboard shortcuts for Editing within Tree and Table Views• 
Keyboard shortcuts for the Preferences Dialog• 
Keyboard shortcuts for Text Editing Fields• 

Keyboard Shortcuts for the Desktop and Child Windows

Action Keystroke Notes

New File Ctrl-N

Open File Ctrl-O

Save File Ctrl-S

Save File As Ctrl-A

Save All Files Ctrl-L

Open Workspace Ctrl-ALT-O

Save Workspace Ctrl-ALT-S

Tile Horizontally Ctrl-H

Tile Vertically Ctrl-V

Maximise Windows Ctrl-M

Restore Windows Ctrl-R

Minimise Windows Ctrl-I

Closes Child Window Ctrl-F4

Moves Child Window Ctrl-F7

Resizes Child Window Ctrl-F8

Minimizes Child Window Ctrl-F9

Switch to next Child Window on the
Desktop

Ctrl-F6
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Keyboard Shortcuts for Tree Views

Action Keystroke Notes

Expands current Object Right arrow

Collapses current Object, or moves focus
to Parent Object

Left arrow

Moves focus up one Object Up arrow

Moves focus down one Object Down arrow

Moves focus to first Object in Tree View Home

Moves focus to last Object in Tree View End

Moves up one view Page Up

Moves down one view Page Down

Selects all Object in Tree View Ctrl-A, Ctrl-/

Deselects all Object in Tree View Ctrl-\

Extends selection down Shift-down
arrow

Extends selection up Shift-up arrow

Extends selection to beginning of Tree
View

Shift-Home

Extends selection to end of  Tree View Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Shortcuts for Table Views

Action Keystroke Notes

Moves up one row Up arrow
Shift-Return

Moves down one row Down arrow
Return 

Scrolls up one view Page Up

Scrolls down one view Page Down

Moves focus and view to first cell in the
current row

Home

Moves focus and view to last cell in the
current row

End

Moves focus and view to first cell in the
current column

Ctrl-Home

Moves focus and view to last cell in the
current column

Ctrl-End

Allows editing in a Category cell F2, Down Arrow

Allows editing in a Name cell. F2

Resets cell to the state it was in before it
was edited

Escape

Selects entire table Ctrl-A

Extends selection up one row Shift-up arrow

Extends selection down one row Shift-down
arrow

Extends selection to beginning of table Ctrl-Shift-Home

Extends selection to end of table Ctrl-Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Editing Short Cuts for both Tree and Table Views

Action Keystroke Notes

Undo Ctrl-Z

Redo Ctrl-Y

Cut Ctrl-X

Copy Ctrl-C

Paste Ctrl-V

Find Ctrl-F

Find Next F3

Goto Ctrl-G

Insert Object INS Not allowed on
Collections

Delete Object DEL Not allowed on
Collections

Rename Object F4 Single Named Object
Only

Initialise Object F5

List References F6 Single Named Object
Only

Export to MIDI Edit Buffer F8 Single Voice or
Performance Only

Export to MIDI Memory Shift-F8 Voices or
Performances Only

Import from MIDI Edit Buffer F9 Single Voice or
Performance Only

Import from MIDI Memory Shift-F9 Voices or
Performances Only
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Keyboard Shortcuts for the Preferences Dialog

Action Keystroke Notes

Navigates through tabs Arrow keys

Moves from tab to its associated content
pane

Ctrl-down arrow

Moves from content pane to its
associated tab

Ctrl-up arrow

Keyboard Shortcuts for Text Editing Fields

Action Keystroke Notes

Moves insertion point one character to
the right

Right arrow

Moves insertion point one character to
the left

Left arrow

Moves insertion point to beginning of
next word

Ctrl-right arrow

Moves insertion point to beginning of
previous word

Ctrl-left arrow

Moves insertion point to beginning of
field

Home

Moves insertion point to end of field End

Submits text entry Enter, Return

Extends selection to beginning of line Shift-Home

Extends selection to end of line Shift-End

Extends selection one character to the
left

Shift-left arrow

Extends selection one character to the
right

Shift-right arrow

Extends selection to next word Shift-Ctrl-right
arrow

Extends selection to previous word Shift-Ctrl-left
arrow
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Credits
Jim Atfield for general debugging duties, including OSX compatibility, and for also checking out the
behaviour of the installer on MAC OSX, and then for loaning me his iMac so that I could sort out some
more pervasive issues. I now have my own Mac so I don't have to keep borrowing Jim's, or hassling
him for OSX duties anymore, but OSX support all started with Jim's help.

• 

3rd party software used in fs.factory
The following 3rd part software is used to build fs.factory and provide some program features.

CoreMIDI4J License

fs.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Table Filter License

fs.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Apache Derby License

fs.factory makes use of Apache Derby to provide the library function, which is issued under the Apache 2.0
License.

Apache Log4J License

fs.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

Dom4J License

fs.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Java Wizard License

The fs.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

I have adapted the Wizard software to allow me to display two progress bars in the Wizard. If anybody wishes
to have the source code for how I did this, please email me at supportx@xfactory-librarians.co.uk and I will
happily provide the adapted source code.
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fs.factory License
The unregistered version of fs.factory allows you to evaluate the features of the program, which are fully
functional except the File Save, MIDI Export and Librarian features.

However, fs.factory cannot be included as part of a commercial distribution or on other web sites without the
express permission of the Author. I am happy for you to provide links to www.xfactory-librarians.co.uk, to
maximise public access to fs.factory.

fs.factory license files are issued to users who have registered fs.factory, to gain access to the File Save, MIDI
Export and Librarian features. If you have been issued with a license key you are not allowed to distribute a
license key to other users. Please respect this, and the amount effort I have put into making this application.

You are permitted to install and activate fs.factory on two computers, for which the license is valid.

If you wish to install and activate fs.factory on more than two computers, then an additional license can be
purchased at 50% of the cost of the main license.

The Author retains the copyright on the program and all of its originally developed features.

Disclaimer
Like all software products, this software is provided "AS IS", and without any warranties expressed or implied.
But hey, remember, you're getting it for a very low cost!

I have worked hard to ensure this software works correctly, as I certainly don't want it trashing my data.
However, I cannot be held liable for any problems arising as a consequence of you using this software on
your computer and your data. You use this product at your risk.

Like all new products, please proceed and evaluate with care, and ensure that all your important data files are
backed up before installation and evaluation.

Having gotten that out of the way, if you do encounter any problems, please submit a bug report
to support@xfactory-librarians.co.uk, and I will endeavour to provide a fix for any reported problems.

Licensing Conditions for 3rd party software
Apache Derby License

fs.factory makes use of Apache Derby to provide the library function, which is issued under the Apache 2.0
License.

Apache Log4J License

fs.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

CoreMIDI4J License

fs.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Dom4J License

fs.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Java Wizard License

The fs.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

 fs.factory License 86

http://www.xfactory-librarians.co.uk/
mailto:support@xfactory-librarians.co.uk
http://db.apache.org/derby/
http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/licenses/LICENSE-2.0
https://logging.apache.org/log4j/2.x/
http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/licenses/LICENSE-2.0
https://github.com/DerekCook/CoreMidi4J
https://github.com/DerekCook/CoreMidi4J/blob/master/LICENSE.md
https://github.com/DerekCook/CoreMidi4J/blob/master/LICENSE.md
https://dom4j.github.io/
https://www.maplesoft.com/support/help/Maple/view.aspx?path=License%2Fdom4j
https://wizard.dev.java.net/
http://www.opensource.org/licenses/cddl1.php


Table Filter License

fs.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Tritonus License

fs.factory makes use of Tritonus Java Sound Extensions, which is issued under the GNU Lesser General
Public License.
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